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1 Locating HP resources

This chapter provides information on the following HP resources for your workstation:

° Product information on page 2

o HP Cool Tools

° Regulatory information
o Parts and accessories
° System board

o Serial number

° Linux

° Product support on page 3

o Additional information

o Technical support

° Business Support Center

° IT Resource Center

° HP Authorized Support and Service Provider
0 HP Business and IT Services

° HP Hardware Support Services

° Channel Services Network

° Product documentation on page 4

° User documentation
o Product notifications
o QuickSpecs

° Warranty information

° Product diagnostics on page 5

0 Documentation and Diagnostics CD

° Diagnostics tools
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° Beeps and LED codes

° Web-based support tools

° Product updates on page 5

° Software, BIOS, and driver updates

° Operating system update

Product information

2

Table 1-1 Product information

Topic

Location

Locating HP Cool Tools information

Most HP Workstations come loaded with additional software
that is not automatically installed when you first boot your
system. Additionally, a number of valuable pre-installed
tools on your workstation can enhance your workstation
experience. To access or learn more about these
applications, choose one of the following options:

e  Click the HP Cool Tools icon on the desktop.

e  Open the HP Cool Tools folder by selecting Start >
All Programs > HP Cool Tools.

To learn more about these applications, click HP Cool
Tools—Learn More.

To install or launch the applications, click the appropriate
application icon.

Locating regulatory information

Refer to the Safety & Regulatory Information guide on the
Documentation and Diagnostics CD for product Class
information. You can also refer to the label on the
workstation chassis.

Locating parts and accessories

For complete and current information on supported
accessories and components, visit http://www.hp.com/go/
workstations.

Locating information about the
system board

The inside of the access panel contains an illustration of the
system board layout. Also, you can find additional
information by reviewing the Service and Technical
Reference Guide on the Documentation and Diagnostics
CD or on the Web at http://www.hp.com/support/
workstation_manuals/.

Locating the serial number and
Certificate of Authenticity (COA)
label (if applicable)

The serial number labels are either on the top panel or on
the side of the unit and at the rear of the unit, depending on
the workstation model. The COA label is generally located
on the top panel or side panel near the serial number label.
Refer to Ventilation, COA label, and serial number label
information on page 9 for more information.

Locating information for Linux on HP
workstations

For information on running Linux on HP workstations, visit
http://www.hp.com/linux/.

Chapter 1 Locating HP resources
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Product support

Table 1-2 Product support

Topic

Location

Locating additional information

For online access to technical support information and tools,
visit http://www.hp.com/go/workstationsupport. Support
resources include Web-based troubleshooting tools,
technical knowledge databases, driver and patch
downloads, online communities, and proactive notification
services.

How to contact technical support

Before you call technical support, see Calling technical
support on page 32 for more information. To facilitate your
call, see Calling technical support on page 32 for a listing
of information you need to have available before you call.

For U.S. and Canada, call 1-800-HPINVENT.

For a listing of all worldwide technical support phone
numbers, visit http://www.hp.com/support/, select your
region, and click Contact HP in the upper-left corner.

Locating the Business Support
Center (BSC)

For software/driver downloads, warranty information,
single-topic documents, product bulletins, and QuickSpecs,
visit http://www.hp.com/go/bizsupport.

Locating the IT Resource Center
(ITRC)

Visit http://www.itrc.hp.com/ for a searchable knowledge
base for IT professionals.

Locating an HP Service Center

Visit http://hp.com/go/bizsupport to find your nearest
service provider.

Locating HP Business and IT
Services.

For business and IT information, visit http://www.hp.com/
hps!/.

Locating HP Hardware Support
Services information

For hardware service information, visit http://www.hp.com/
hps/hardware/.

How an Authorized Service Provider
can locate a Channel Services
Network (CSN)

For part and warranty information, visit http://www.hp.com/
partners/csn/.

NOTE: The Channel Services Network is available to
Authorized Service Providers only.

Locating warranty information

To locate base warranty information, visit
http://www.hp.com/support/warranty-lookuptool.

To locate an existing Care Pack, visit http://www.hp.com/go/
lookuptool.

To extend a standard product warranty, visit
http://www.hp.com/hps/carepack. HP Care Pack Services
offer upgraded service levels to extend and expand a
standard product warranty.

ENWW

Product support


http://www.hp.com/go/workstationsupport
http://www.hp.com/support/
http://www.hp.com/go/bizsupport
http://www.itrc.hp.com/
http://hp.com/go/bizsupport
http://www.hp.com/hps/
http://www.hp.com/hps/
http://www.hp.com/hps/hardware/
http://www.hp.com/hps/hardware/
http://www.hp.com/partners/csn/
http://www.hp.com/partners/csn/
http://www.hp.com/support/warranty-lookuptool
http://www.hp.com/go/lookuptool
http://www.hp.com/go/lookuptool
http://www.hp.com/hps/carepack

Product documentation

Table 1-3 Product documentation

Topic Location
Locating HP user documentation, For the latest online documentation, visit
white papers, and third-party http://www.hp.com/support/workstation_manuals.
documentation

Signing up for product notifications  Subscriber's Choice is an HP program that allows you to
sign up to receive driver and software alerts, proactive
change notifications (PCNs), the HP newsletter, customer
advisories, and more. Sign up at http://www.hp.com/go/
subscriberschoice/.

Customer advisories and product change notifications are
also available on http://www.hp.com/go/bizsupport/.

Locating workstation QuickSpecs The Product Bulletin contains QuickSpecs for HP
Workstations. QuickSpecs provide an overall specification
review of your product. It includes information about its
features including the operating system, power supply,
memory, processor, and many other components of the
system. To access the QuickSpecs, visit
http://www.hp.com/go/productbulletin/.

Locating Customer Advisories, To find advisories, bulletins, and notices:
Security Bulletins, and Notices
1. Visit http://www.hp.com/go/workstationsupport.

2. Select the desired product.

3. From the Resources for your selected product menu,
select See more...

4. Use the scroll bar to select Customer Advisories,
Customer Bulletins, or Customer Notices. The
selection presents an index of related information.

Locating user tasks on the You can locate user tasks in the preinstalled documentation
Preinstalled documentation on the workstation hard drive by selecting Start > All
Programs > HP Documentation.

NOTE: If you installed your own operating system image
after receiving your workstation and the HP documentation
on the hard drive was then lost or is no longer accessible,
the documentation can also be found on the Documentation
and Diagnostics CD and at http://www.hp.com/support/
workstation_manuals
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Product diagnostics

Table 1-4 Product diagnostics

Topic

Location

Exploring the contents on the

Documentation and Diagnostics CD

For information on using the CD as a documentation tool or

a diagnostics tool, see the instructions on the CD.

The Documentation and Diagnostics CD includes:

Setup and Troubleshooting Guide
Service and Technical Reference Guide
Safety and Comfort Guide

Safety & Regulatory Information Guide
HP Insight Diagnostics utility

User task-specific instructions

Locating diagnostics tools

For diagnostics tools, see the following resources :

The Documentation and Diagnostics CD contains the
HP Insight Diagnostics utility. To use this utility, see
Troubleshooting on page 22.

Use utilities such as:

° Instant Chat

° Instant Support

° Diagnose Problem

To access information about your workstation, visit
http://www.hp.com/go/workstationsupport.

Use the Start > Support menu selection on your
workstation.

Determining the meaning of beeps
and LED codes

Refer to Diagnostic lights and audible (beep) codes
on page 28 for detailed information about beep and Light
Emitting Diode (LED) codes applicable to the workstation.

Accessing Web-based support tools

to resolve workstation problems

Refer to Instant Support and Active Chat on page 23 for

more information on how to receive support.

Product updates

Table 1-5 Product updates

Topic

Location

Locating the latest software,
BIOS, and drivers

Verify that you have the latest drivers for your system by
visiting http://www.hp.com/go/workstationsupport.

Reinstalling the operating system

Refer to Setting up operating system software in this document
for more information on how to load the operating system.
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Table 1-5 Product updates (continued)

Information on 64-bit operating For information on availability and compatibility of the Windows
systems and Linux 64—bit operating systems on HP workstations, visit
http://www.hp.com/go/wsos.

Information on Linux and HP For information on using Linux on HP workstations, including
solutions, products, and services, visit http://www.hp.com/
linux/.

Warnings and cautions

6

A

WARNING! & Any surface or area of the equipment marked with this symbol indicates the presence
of a hot surface or hot component. If this surface is contacted, the potential for injury exists. To reduce
the risk of injury from a hot component, enable the surface to cool before touching.

WARNING! A Any surface or area of the equipment marked with this symbol indicates the presence
of an electrical shock hazard. To reduce the risk of injury from electrical shock, do not open any enclosed
area marked with this symbol.

WARNING! To reduce the risk of electric shock or damage to your equipment;
— Do not disable the power cord grounding plug. The grounding plug is an important safety feature.
— Plug the power cord in a grounded (earthed) outlet that is easily accessible at all times.

— Disconnect power from the equipment by unplugging the power cord from the electrical outlet.

WARNING! To reduce the risk of serious injury, read the Safety & Comfort Guide. It describes proper
workstation setup, posture, health, and work habits for computer users, and provides important electrical
and mechanical safety information. This guide is located at http://www.hp.com/ergo and on the
documentation CD (if one is included with the product).

[ ] L]
WARNING! Ifaproductis shipped in packaging marked with this symbol, %Ig the product must always
be lifted by two persons to avoid personal injury due to product weight.

CAUTION: Static electricity can damage the electronic components of the workstation. Before
beginning these procedures, be sure you discharge static electricity by briefly touching a grounded metal
object.

CAUTION: Observe the following cautions when removing or replacing a processor:

— Installing a processor incorrectly can damage the system board. Contact an HP authorized reseller
or service provider to install the processor. If you plan to install the processor yourself, read all of the
instructions carefully before you begin.

— Failure to follow the workstation preparation instructions can result in an improperly installed
processor, causing extensive workstation damage.

— Processor socket pins are delicate and bend easily. Use extreme care when placing the processor
in the socket.

Chapter 1 Locating HP resources ENWW
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/A CAUTION: To prevent damage to the workstation, observe the following Electrostatic Discharge
(ESD) precautions while performing the system parts removal and replacement procedures:

— Work on a static-free mat.

— Wear a static strap to ensure that any accumulated electrostatic charge is discharged from your body
to the ground.

— Create a common ground for the equipment you are working on by connecting the static-free mat,
static strap, and peripheral units to that piece of equipment.

Bf NOTE: HP accessories are for use in HP Workstation products. They have been extensively tested
for reliability and are manufactured to high quality standards.

ENWW Warnings and cautions 7



2 Setting up the Hardware

This chapter provides information on setting up of the workstation hardware.

Quick setup

A WARNING! To reduce the risk of electric shock or damage to your equipment:

— Do not disable the power cord grounding plug. The grounding plug is an important safety feature.

— Plug the power cord in a grounded (earthed) outlet that is easily accessible at all times.

Ef NOTE: Your workstation might not have PS/2 mouse and keyboard connectors as shown in Figure
2—1. Alternatively, connect the mouse and keyboard to appropriate USB connectors (see Table 2-2).

Figure 2-1 Workstation quick setup example

Ef NOTE: After setting up your workstation hardware, connect other peripheral components (such as a
printer) according to the instructions included with the device. For more information on your HP
Workstation, see the Documentation and Diagnostics CD or visit http://www.hp.com/go/
workstationsupport.

8 Chapter 2 Setting up the Hardware ENWW
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To rapidly set up your workstation hardware, complete the following steps:

1.

3.

After unpacking your HP Workstation, locate an accessible workspace to set up the system and
connect the mouse, keyboard, and power cables to your workstation. Connect the power cable
from the workstation to a power outlet.

Connect the workstation monitors, as appropriate for your system configuration, as follows:

e If your workstation has a PCI-Express graphics card with a DMS-59 output receptacle (see
Table 2—2), use an appropriate adapter to connect your monitors. Adapters are available to
connect the DMS-59 output to two DVI or two VGA monitors. Figure 2—1 (lower inset)
illustrates using an adapter to connect dual DVI or VGA monitors to the workstation DMS-59
output.

e If your workstation has a PCI-Express graphics card with two DVI output receptacles (see
Table 2—2), you can connect a monitor to each DVI receptacle (using appropriate adapters,
if required).

Bf NOTE: On asystem with two DVI connections, the primary display port (used to display
BIOS and other important information) will be port #1; defined as the port physically closest
to the system board, and located on the PCI-Express card bulkhead installed closest to the
workstation chassis rear panel.

e If your workstation does not have a PCI-Express graphics card, but, alternatively, has an
SVGA (see Table 2-2) and a DVI-D output receptacle located on the workstation chassis rear
panel, you can connect a monitor to each output.

Connect a power cable from each monitor to a power outlet, as shown in Figure 2—1.

Ventilation, COA label, and serial number label information

ENWW

Proper ventilation for your system is very important. See Figure 2—2 and the following notes to properly
position your system for maximum airflow.

Operate the computer on a sturdy, level surface.

Place the computer in an area that is relatively cool with adequate ventilation. Provide at least 6
inches of clearance at the front and back of the workstation. For cabinet installation, ensure
adequate cabinet ventilation and ensure that the ambient temperature within the cabinet does not
exceed 35° C (95° F).

Quick setup 9



e Never restrict the incoming or outgoing airflow of the computer by blocking any vents or air intakes.

Figure 2-2 Workstation ventilation

T Y
A

|
B
4
\_E lr o
Wl v
-

Each HP Workstation has two unique serial number labels (1) and a Certificate of Authentication (COA)
label (2) (for Windows®-preinstalled systems only) as shown in Figure 2—2. In general, the serial number
labels can be found on the top panel or on the side of the unit and at the rear of the unit. Keep this
number available when contacting customer service for assistance. The COA label is generally located
on the top panel or side of the unit near the serial number label.

B NOTE: If you must restore the operating system with Windows OEM CDs (installing without using the
Restore Plus! CDs), refer to the appropriate section of the chapter Setting up operating system software

on page 14.

Front and rear panel components

This section provides information on workstation front and rear panel controls and components.

10 Chapter 2 Setting up the Hardware ENWW



Front panel components

Figure 2-3 is for reference only, and shows examples of different workstation series. Your HP

workstation might look different.

Figure 2-3 Workstation series front panel examples

xw4000 Series xw6000 Series

xw8000/xw9000 Series

ENWW

Table 2-1 Front panel component examples’

Item Symbol Description Item Symbol Description

1 Optical drive 6 n Headphone connector

2 5.25-inch drive bay 7 - USB 2.0 (Universal Serial Bus) ports
3 Diskette drive (optional) 8 g Hard drive activity light

4 "Q. IEEE-1394a connector 9 d) Power button

5 ':':' Microphone connector 10 Power on light

Refer to the Service and Technical Reference Guide for your workstation for specific front panel component information.

Front and rear panel components
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Rear panel components

Figure 2—4 is for reference only and show examples of rear panel connectors that might be located on
your workstation. Your HP workstation has some combination of these connectors, depending upon

workstation model and configuration.

Figure 2-4 Workstation connector and control examples

2302 & L

Table 2-2 Rear panel connector and control description

Item  Symbol Description Item Symbol Description

1 Power cord connector 10 (> Audio line-out connector
7

2 Voltage Select Switch 11 (3 Audio line-in connector

3 6 PS/2 Mouse connector (green) 12 DVI DVI-D Monitor Connector

NOTE: Might not be available on all

NOTE: Your workstation might have a

workstations. DVI-I Monitor Connector instead. This
connector will have two additional pins
above and two below the horizontal flat
blade to carry integrated analog signals.
4 PS/2 Keyboard connector (purple) 13 e-SATA Connector

NOTE: Might not be available on all

NOTE: Might not be available on all

workstations. workstations.

5 - USB 2.0 ports 14 Mini SAS Connector
NOTE: Might not be available on all
workstations.

6 Serial connector 15 PR IEEE-1394a connector

lolel 2

NOTE: Might not be available on all
workstations.

7 s RJ-45 network connector 16 SAS Connector

12 Chapter 2 Setting up the Hardware
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Table 2-2 Rear panel connector and control description (continued)

Item  Symbol Description Item  Symbol Description
NOTE: Might not be available on all
workstations.

8 E Parallel connector * 17 DMS-59 high density graphics connector

NOTE: Might not be available on all
workstations.

NOTE: Might not be available on all
workstations.

9 SVGA Monitor Connector

* Refer to the Service and Technical Reference Guide for your workstation for specific rear panel component information.
The rear panel connectors are labeled with industry-standard icons and colors to assist you in connecting your peripheral

devices.

Additional rear panel components can include those shown in the examples in Figure 2-5. Your
workstation has some combination of these components, depending upon workstation model and

configuration.

Figure 2-5 Additional rear panel component examples

xw4000 Series xw6000 Series xw8000/xw9000 Series
Item Description
1 Built-in Self Test (BIST) LED
2 Universal chassis clamp opening
3 Cable lock slot
4 Padlock loop
5 Access panel key

NOTE: Not all workstations models have the key lock.

6 PCI expansion slot access openings (each slot opening typically covered with blank filler panel when not use).

Front and rear panel components 13



3 Setting up operating system software

This chapter provides setup information for the Windows Vista® Business , Microsoft Windows XP, Red
Hat Linux, and Red Flag Linux operating systems. it also provides information on how to verify that you
have the latest BIOS, drivers, and software updates installed on your workstation.

/A CAUTION: Do not add optional hardware or third-party devices to the HP workstation until the
operating system is successfully installed. Adding hardware might cause errors and prevent the
operating system from installing correctly.

Setting up software for Windows Vista Business

When you first apply power to the workstation, the operating system is installed. This process takes
approximately 5 to 10 minutes. Carefully follow the instructions on the screen to complete the installation.

/A CAUTION: After the automatic installation has started, do not turn off the workstation until the process

is complete. Turning off the workstation during installation can damage the installation and operation of
this software.

Ef NOTE: After you have selected a language during initial boot of the operating system, the language
will be locked in on the hard drive. If the system is restored with HP Backup and Recovery, only the
previously selected language can be installed. If using RestorePlus! DVDs, the RestorePlus! DVD
checks for the language stored on the hard drive and restores only the original preinstalled language.
If a new hard drive is installed or no language is found on the disk, the RestorePlus! DVD installs any
language requested.

For complete operating system installation and configuration instructions, see the operating system
documentation that was provided with the workstation. Additional information is available in the online
help tool after you successfully install the operating system.

Restoring the Windows Vista Business operating system

Your workstation has several methods to restore your Windows Vista Business operating system to a
near-factory state or to the state of the system at a predefined restore point. Your system has a recovery
partition on the system hard drive that contains software and data required for the restore process as

described in the following sections.

Ef NOTE: If you must restore the operating system with Windows XP OEM CDs (installing without using
the Restore Plus! CDs), you must call Microsoft in order to provide the company with a Stock Keeping
Unit (SKU) number. The SKU information is on the service tag and is the OS product number in the
lower right hand section of the tag. It should display “OS: XXXXXXX,” where “XXXXXXX” is the OS
product number.

14 Chapter 3 Setting up operating system software ENWW



The HP Backup and Restore (HPBR) process

The Windows operating system and device drivers (for devices shipped with the system) are reinstalled
using this process. The HPBR process can be executed from DVD, CD, or from the recovery partition
contained on your system hard drive. To launch the HPBR, select Start > All Programs > HP Backup
& Recovery > HP Backup and Recovery Manager.

/A CAUTION: Backup your data before you attempt any operating system restore. All data on the
Windows partition will be deleted when you perform a system restore using the HPBR process. However,
the recovery partition on the system drive and other partitions should not be affected.

Creating system recovery DVDs or CDs

You can create a set of the DVDs or CDs from your system if you have a DVD/CD burner. After launching
the HP Backup and Restore Manager, you can create 1SO images of the factory image, or burn them
directly to CD or DVD media. You can also create a supplemental HP Backup and Recovery Manager
CD. (There might be additional CDs you can create depending on the options you purchased.) You also
have the option to move images of the CDs to another location, such as a network share, to be burned
to DVD or CD at a later time or from another system.

Restoring from HPBR DVDs or CDs

To start the system recovery process, boot from the previously-created DVD or CD and carefully follow
the online instructions.

Restoring directly from the recovery partition
To start the HPBR system restore process from the Recovery Manager, follow these steps:
1. Boot the workstation.
2. Press the F11 key when prompted on the boot splash screen to enter the Recovery Manager.

3. Follow the prompts to restore the system to a factory-like condition.

Reclaiming hard drive space from the recovery partition

To reclaim hard drive space, you can remove only the HP Recovery Partition or you can completely
uninstall the HP Backup and Recovery Manager application.
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/A CAUTION: Deleting the HP Recovery Partition or uninstalling the HP Backup and Recovery Manager
application reduces or eliminates the ability to recover the system.

If the recovery partition is removed: (1) The F11 Emergency Recovery function is not available, (2) The
ability to recover the system from data on the recovery partition is lost, (3) Any recovery images
contained in the recovery partition are deleted, and (4) The ability to create a recovery media set is lost.

If you uninstall the HP Backup and Recovery Manager application, emergency recovery, as well as data
backup and recovery, are no longer possible.

Removing only the recovery partition — The recovery partition can be removed by selecting

Remove HP Recovery Partition in the HP Backup & Recovery program folder. When the HP
Recovery Partition is removed; the recovery partition is deleted, the user partition is extended to
reclaim the unused hard drive space, and the F11 boot prompt is removed. The HP Backup and
Recovery Manager application remains and can be used for data backup and restore.

Uninstalling the HP Backup and Recovery Manager application — The HP Backup and
Recovery Manager application can be uninstalled by selecting the Windows Control Panel >
Programs and Features utility. When the HP Backup and Recovery Manager application is
uninstalled; the recovery partition is deleted, the user partition is extended to reclaim the unused
space, and the F11 boot prompt is removed.

Ordering backup software

You can order a Recovery Disc Set from HP by contacting the HP support center. To obtain the support
center telephone number for your region:

1.
2,
3.

Visit http://welcome.hp.com/country/us/en/wwcontact _us.html.

Select your region.

Under the Call HP heading, click Technical support after you buy.

Ef NOTE: Before calling HP to order the software, be sure to have the serial number of your workstation
available. Refer to Ventilation, COA label, and serial number label information on page 9 for details.

Transferring files and settings to your Windows Vista Business workstation
using Windows Easy Transfer

Windows Easy Transfer, the Microsoft data migration tool, provides a guide that helps you choose what
files and data to transfer from another Windows computer to your Windows Vista Business workstation
and how to transfer it. You can use one of the following interconnect or storage methods with Windows
Easy Transfer to migrate data from another Windows computer to your workstation:

Network — Can be used when both the source computer and your workstation are connected to
the same network.

Easy Transfer Cable — A specially designed USB cable that can connect the source computer
to your workstation when completing a Windows Easy Transfer. Note that an Easy Transfer Cable
is not a standard USB cable, but is also commonly available from local electronic suppliers.

DVDs or CDs — Can be used if you have writeable DVD or CD drives on the source computer
and your workstation.

USB flash drive or an external hard drive — Can access both the source computer and your
workstation.

16 Chapter 3 Setting up operating system software ENWW


http://welcome.hp.com/country/us/en/wwcontact_us.html

To use the Windows Easy Transfer tool, select Start > All Programs > Accessories > System
Tools > Windows Easy Transfer.

Bf NOTE: For more information on using Windows Easy Transfer with your workstation, visit
http://www.microsoft.com/windows/products/windowsvista/features/details/easytransfer.mspx

Software setup for Microsoft Windows XP Professional

When you first apply power to the workstation, the operating system is installed. This process takes
approximately 5 to 10 minutes. Carefully follow the instructions on the screen to complete the installation.

/A CAUTION: After the automatic installation has started, do not turn off the workstation until the process
is complete. Turning off the workstation during installation can damage the installation and operation of
this software.

NOTE: After you have selected a language during initial boot of the operating system, the language
will be locked in on the hard drive. If the system is restored, the restore CD checks for the language
stored on the hard drive and restores only the original preinstalled language. If a new hard drive is
installed or no language is found on the disk, the Recovery CD will install any language requested. A
language selection is not required for the 64-bit operating system.

For complete operating system installation and configuration instructions, see the operating system
documentation that was provided with the workstation. Additional information is available in the online
help tool after you successfully install the operating system.

Restoring the Windows operating system

Your workstation has a several methods to restore your Windows XP operating system to a near-factory
state, or to the state of the system at a predefined restore point. Your system has a recovery partition

on the system hard drive that contains software and data required for the restore process as described
in the following sections.

=’ NOTE: If you must restore the operating system with Windows XP OEM CDs (installing without using
the Restore Plus! CDs), you must call Microsoft in order to provide the company with a Stock Keeping
Unit (SKU) number. The SKU information is on the service tag and is the OS product number in the
lower right hand section of the tag. It should display “OS: XXXXXXX,” where “XXXXXXX” is the OS
product number.

The RestorePlus! process

The Windows operating system and device drivers (for devices shipped with the system) are reinstalled
using this process. Some application software might not be restored using the RestorePlus! process. In
this case you must install the application software from the appropriate application CD. The RestorePlus!
process can be executed from CD or from the recovery partition contained on your system hard drive.

/A CAUTION: Backup your data before you attempt any operating system restore. All data on the
Windows partition will be deleted when you restore using the RestorePlus! process. However, the
recovery partition on the system drive and other partitions should not be affected.

Creating a RestorePlus! CD

You can create a set of the CDs from your system if you have a CD burner. When you first boot your
system, you are prompted to make CDs for RestorePlus!, the Windows operating system, and a
supplemental HP Backup and Recovery Manager CD. (There might be additional CDs you can create,

ENWW Software setup for Microsoft Windows XP Professional 17


http://www.microsoft.com/windows/products/windowsvista/features/details/easytransfer.mspx

depending on the options you purchased.) You also have the option to move images of the CDs to
another location, such as a network share, to be burned to CD at a later time or from another system.

Restoring from RestorePlus! CDs

To start the RestorePlus! process, boot from the RestorePlus! CD and carefully follow the online
instructions.

Restoring from RestorePlus! on the recovery partition
Follow these steps to start the RestorePlus! process from the Emergency Recovery menu:
1. Boot the workstation.

2. Pressthe F11 key when prompted during the boot process to enter the Emergency Recovery menu.
The F11 prompt appears briefly during the boot process.

3. Select Recover PC’s factory installed operating system, drivers, utilities, and applications
from the Emergency Recovery menu.

B NOTE: Some applications might not be restored using this method.

HP Backup and Recovery Manager restore points

HP Backup and Recovery Manager is preinstalled on your workstation. This software enables you to
backup and restore your system and data using a restore point which is a snapshot of the system
partition. A restore point can be used to return the system partition back to its state when the restore
point was created.

Refer to the Service and Technical Reference Guide for your workstation for details on using the HP
Backup and Recovery Manager, including restore points.

Reclaiming hard drive space from the recovery partition

To reclaim hard drive space, you can remove only the HP Recovery Partition or you can completely
uninstall the HP Backup and Recovery Manager application.

/A CAUTION: Deleting the HP Recovery Partition or uninstalling the HP Backup and Recovery Manager
application reduces or eliminates the ability to recover the system.

If the recovery partition is removed: (1) The F11 Emergency Recovery function is not available, (2) The
ability to recover the system from data on the recovery partition is lost, (3) Any RestorePlus! media
contained in the recovery partition is deleted, and (4) The ability to create the RestorePlus! CD set is
lost.

If you uninstall the HP Backup and Recovery Manager application, emergency recovery, as well as data
backup and recovery, are no longer possible.

e Removing only the recovery partition — The recovery partition can be removed by selecting
Remove HP Recovery Partition in the HP Backup & Recovery program folder. When the HP
Recovery Partition is removed; the recovery partition is deleted, the user partition is extended to
reclaim the unused hard drive space, and the F11 boot prompt is removed. The HP Backup and
Recovery Manager application remains and can be used for data backup and restore.

e Uninstalling the HP Backup and Recovery Manager application — The HP Backup and
Recovery Manager application can be uninstalled by selecting the Windows Control Panel >
Programs and Features utility. When the HP Backup and Recovery Manager application is
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uninstalled; the recovery partition is deleted, the user partition is extended to reclaim the unused
space, and the F11 boot prompt is removed.

Ordering backup software

You can order a Recovery Disc Set from HP by contacting the HP support center. To obtain the support
center telephone number for your region:

1. Visit http://welcome.hp.com/country/us/en/wwcontact_us.html.

2. Select your region.

3. Under the Call HP heading, click Technical support after you buy.

Bf NOTE: Before calling HP to order the software, be sure to have the serial number of your workstation
available. Refer to Ventilation, COA label, and serial number label information on page 9 for details.

Software setup for Red Hat Linux

This section contains information for installing, setting up, and customizing your HP Linux Workstation
when running the Red Hat Linux operating system.

Setting up and customizing Red Hat Linux-preinstalled workstations

If you have a Linux-preinstalled workstation, follow the instructions in this section to set up your OS and
software.

After the boot process completes, you can view additional HP Linux documentation by opening your
Internet browser (automatically set to use the local HP documentation page as its default). You can also
access Linux Web links for Red Hat (Internet access required) by using your Internet browser.

Bf NOTE: For additional information concerning the setup of preinstalled Linux or Linux-enabled
workstations, see the HP Workstation User Manual for Linux, which is located at http://www.hp.com/
support/linux_user_manual. For additional information about HP and Linux, visit http://www.hp.com/
linux.

Starting Red Hat Linux

The first time the HP Workstation is booted, the Red Hat First Boot utility appears. This program allows
you to enter your password, network, graphics, time, and keyboard settings for your workstation.

Downloading the latest HP driver CD

Refer to “Obtaining the HP Installer Kit for Linux from the HP Support Website” in the HP Workstations
User Manual for Linux.

Installing with the HP driver CD

Refer to “Installing with the HP Installer Kit for Linux” in the HP Workstations User Manual for Linux.

Restoring Red Hat Linux

The HP Driver CD and Red Hat box set are required to restore the Red Hat Linux Operating System.
Download the latest HP Driver CD (Downloading the latest HP driver CD) to receive any new
enhancements.
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Preloaded Red Hat Linux systems have Red Hat ISO's icon that is available on the desktop. Click this
icon to go to the /iso directory. This directory contains the binary and source ISO files. This directory
also contains the driver CD ISO, which is the same as the CD that is shipped with the workstation. Follow
the instructions in the Readme file in the /iso directory to burn the ISOs to CD.

Bf NOTE: HP recommends that you burn the ISOs to CD to have as backup files.

Installing and customizing Red Hat Linux-enabled workstations

Linux—enabled workstations are not preinstalled with Linux. They require the HP Installer Kit for Linux
and the purchase of a Red Hat box set. The Installer kit includes the HP CDs necessary to complete
the installation of all versions of the Red Hat box set that have been verified to work on HP Workstation
hardware.

Verifying hardware compatibility
To see which Linux versions have been verified to work on HP Workstation hardware:

1. Visit http://www.hp.com/support/workstation_manuals.

2. Select your HP Workstation model.

3. Click the Hardware Support Matrix for Linux link.

Installing the Red Hat Linux operating system

To install the Linux operating system on your Linux-enabled system, see Starting Red Hat Linux and
Restoring Red Hat Linux in the previous sections.

Bf NOTE: For additional information concerning the setup of preinstalled Linux or Linux-enabled
workstations, see the HP Workstation User Manual for Linux, located at http://www.hp.com/support/
linux_user_manual. For additional information about HP and Linux, visit http://www.hp.com/linux.

EY NOTE: For detailed information on Linux installation, see the HP Installer Kit for Linux manual.

Red Hat Linux activation

With your workstation you received an activation card with the title Activate Your Subscription printed
on it. The information on this card is required to activate your Linux subscription with Red Hat Network.
Until activation, your Red Hat Linux operating system is not fully enabled.

To activate Red Hat Linux, click the Activate Your Subscription icon on your desktop, which directs
you to http://www.redhat.com/activate. Follow the instructions at this Web site to activate your
subscription using the information on the card.

HP recommends that you activate your subscription as soon as you connect to the Web.

Bf NOTE: Keep the Red Hat activation card with your workstation registration card for future reference.

Software setup for Red Flag Linux

The Red Flag Linux operating system is not supported by Hewlett-Packard. For more information or for
support of Red Flag Linux visit http://www.redflag-linux.com.
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Verifying your system after first boot

HP continually strives to implement new enhancements that will increase functionality, performance,
and reliability of your HP Workstation. To ensure that your workstation takes advantage of the latest
enhancements, HP recommends that you install the latest BIOS, driver, and software updates on a
regular basis.

After successfully booting your system for the first time:

Verify you have the latest system BIOS loaded; see Upgrading the BIOS on page 21 for
instructions.

Verify you have the latest drivers for your system; see Upgrading device drivers on page 21 for
instructions.

Become familiar with your available HP resources; see Locating HP resources on page 1.

Consider a subscription to Driver Alerts at http://www.hp.com/go/subscriberschoice.

Upgrading the BIOS

To check the current BIOS of your workstation during system power up:

1.
2,

Wait for the F10=setup prompt to appear on the lower right corner of the screen.

Press the F10 key to enter F10 setup. The F10 Setup utility displays your workstation BIOS version
under File > System Information.

Note the workstation BIOS version so that you can compare it with the BIOS versions displayed
on the HP Web site.

To locate and download the latest available BIOS:

1.
2,

Visit http://www.hp.com/go/workstationsupport.

Select Download Drivers and Software from the left menu column under Tasks, and follow the
instructions to locate the latest BIOS available for your workstation.

If the BIOS on the Web site is the same as the version on your system, no further action is required.

If the BIOS on the Web site is a version later than the one on your system, download the appropriate

version for your workstation. Follow the instructions in the release notes to complete the installation.

Upgrading device drivers
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To install hardware devices (such as a printer, display adapter, or network adapter) after the operating
system is installed, the operating system must have access to the appropriate software drivers for the
devices. Device drivers are usually provided on a CD supplied with the peripheral device.

To locate the most current device drivers, visit http://www.hp.com/go/workstationsupport. Select

Download Drivers and Software from the left menu column under Tasks, and follow the instructions

to locate the latest drivers available for your workstation.

If a needed driver is not found, visit the Web site of the manufacturer of the peripheral device.
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Troubleshooting

This chapter provides information on:

e  Self-troubleshooting with HP Insight Diagnostics
e HP troubleshooting resources and tools

e Power-On Self Test (POST) error messages

e Basic troubleshooting tables

e  Calling technical support

Self-troubleshooting with HP Insight Diagnostics

HP Insight Diagnostics is an offline diagnostic utility that allows you to perform system testing. With this
utility, you can test your system hardware and view the hardware configuration information for your
system.

To use the HP Insight Diagnostics utility, insert the Documentation and Diagnostics CD into your optical
drive and reboot. Follow the menu options and directions to begin your testing.

NOTE: If you do not have the Documentation and Diagnostics CD, visit http://www.hp.com/go/
workstationsupport. Select Download Drivers and Software from the left menu under Tasks, and
follow the instructions to locate the latest documentation and diagnostics information available for your
workstation.

For more information on using HP Insight Diagnostics when running the application, click the Help tab
or see the Service and Technical Reference Guide at http://www.hp.com/support/
workstation_manuals.

HP troubleshooting resources and tools

This section provides information on the HP Help and Support Center, E-support, and Helpful Hints for
troubleshooting.

HP Help and Support Center

The HP Help and Support Center is a customized HP user interface that enhances the Windows XP
Help and Support Center Help feature. This customized utility allows you to access specific information
about your HP Workstation such as configuration information by clicking Start > Help and Support
Center. The interface also provides customized help and support links to the HP Web site related to
your HP Workstation.
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B NOTE: The customized HP Help and Support Center is not available on Windows XP Professional

x64 Edition or on Linux.

E-support

Online access and support resources include Web-based troubleshooting tools, technical knowledge
databases, driver and patch downloads, online communities, and product change notification services.

The following Web sites are also available to you:

e  hitp://www.hp.com—Provides useful product information.

° http://www.hp.com/support/workstation _manuals—Provides the latest online documentation.

e  htip://www.hp.com/go/workstationsupport—Provides technical support information for your
workstation.

e  http://www.hp.com/support—Provides a listing of the worldwide technical support phone numbers.
Access the telephone numbers by visiting the Web site, then select your region, and click Contact
HP in the upper-left corner.

e  http://www.hp.com/support/workstation swdrivers—Provides access to software and drivers for
your workstation.

Troubleshooting a problem

To help you troubleshoot problems with your system, HP provides the Business Support Center (BSC).
The BSC is a portal to an extensive selection of online tools. To access BSC and troubleshoot a problem
with your workstation, complete the following:

1. Visit http://www.hp.com/go/workstationsupport.

2. Under the Business Support Center menu on the left, select Troubleshoot a problem.

3. Under Select your product (center window), select Workstations (under personal
computing).

4. Under Select your product, continue with selections as appropriate to your workstation series and
model, and to the problem you are troubleshooting.

Instant Support and Active Chat

HP Instant Support is a set of Web-based support tools that automate and speed up the resolution of
desktop computing, tape storage, and printing problems.

Active Chat enables you to electronically submit a support ticket to HP over the Web. When you submit
a support ticket, Active Chat collects information about the computer and pass it to an online support
specialist. The collection of information might take up to 30 seconds depending on the computer
configuration. When you submit a support ticket, you receive a confirmation message containing your
case ID, the support hours for your location, and the estimated time of response.

For more information about HP Instant Support and Active Chat and how to use them, visit
http://www.hp.com/hps/hardware/hw_professional.html.

BY NOTE: This feature is not available on Windows XP Professional x64 Edition or on Linux.
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Customer Advisories, Customer and Security Bulletins, and Customer Notices

To find advisories, bulletins, and notices:

1.
2,

Visit http://www.hp.com/go/workstationsupport.

Select the desired product (for example, HP Workstation xw6000).

Under Resources for <your selected product> (for example, HP Workstation xw6000), select
See more...

Under Self-Help resources: in the center of the window, choose the desired action and appropriate
information in the scroll list to view the index.

Product Change Notifications

Product Change Notifications (PCNs) provide customers with a notice of changes to their product. Visit

http://www.hp.com and perform a search for PCNs related to your system. To maximize your search
efforts, use the + symbol to locate valid words. For example, to search for PCNs for the xw8200, type
+xw8200 +PCN and press Enter. You can also use the - symbol to exclude certain words. You can also
register with Subscriber's Choice to automatically receive PCNs related to your system. For information
on how to register to Subscriber’s Choice, see Locating HP resources on page 1.

Helpful hints

If you encounter a problem with your workstation, monitor, or software, the following provides a list of
general suggestions that help you isolate and focus on the problem before taking further action.

At startup

Verify that the workstation and monitor are plugged into a working electrical outlet.
Remove all diskettes from your system before turning it on.
Verify that the workstation is turned on and the green power light is on.

If you have installed an operating system other than the factory-installed operating system, check
to be sure that it is supported on your system by visiting http://www.hp.com/go/quickspecs.

Verify that the monitor is turned on and the green monitor light is on.
Turn up the brightness and contrast controls of the monitor if the monitor is dim.

If your workstation has multiple video sources and only a single monitor, the monitor must be
connected to the source selected as the primary VGA adapter. During startup, the other monitor
connectors are disabled; if the monitor is connected to one of these ports, it will not function after
Power-on Self Test (POST). You can select the default VGA source in Computer Setup (F10).

During operation

Look for blinking LEDs on the front of the workstation. The blinking lights are error codes that will
help you diagnose the problem. Refer to the Diagnostic lights and audible (beep) codes section of
this document for information on interpreting diagnostic lights and audible codes.

Press and hold any key. If the system beeps, then your keyboard is operating correctly.

Check all cables for loose or incorrect connections.
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Wake the workstation by pressing any key on the keyboard or the power button. If the system
remains in suspend mode, shut down the system by pressing and holding the power button for at
least four seconds, then press the power button again to restart the system. If the system does not
shut down, unplug the power cord, wait a few seconds, then plug it in again. If it does not restart,
press the power button to start the workstation.

Reconfigure your workstation after installing a non—plug and play expansion board or other option.
Refer to the Hardware installation problems section of this document for instructions.

Be sure that all required device drivers have been installed. For example, if you have connected
a printer, you must install a printer driver.

If you are working on a network, plug another workstation with a different cable into the network
connection. There might be a problem with the network plug or cable.

If you recently added new hardware, remove the hardware and verify if the workstation functions
properly.

If you recently installed new software, uninstall the software and verify if the workstation functions
properly.

If the screen is blank, plug the monitor into a different video port on the workstation if one is
available. Alternatively, replace the monitor with a monitor that you know is working properly.

Upgrade the BIOS. A new release of the BIOS might have been released that supports new features
or fixes your problem.

For more detailed information, see the troubleshooting chapter in the Service and Technical
Reference Guide at http://www.hp.com/support/workstation_manuals.

Customizing the monitor display

You can manually select or change the monitor model, refresh rates, screen resolution, color settings,
font sizes, and power management settings. To do so, right-click the desktop, then click Properties to
change display settings. For more information, see the online documentation provided with the graphics
controller utility or the documentation that came with your monitor.

Power-On Self Test error messages

The POST is a series of diagnostic tests that runs automatically when the system is turned on. Audible,
visual, or both message occur before the operating system boots if the POST encounters a problem.
POST checks the following items to ensure that the workstation system is functioning properly:
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Keyboard

Memory modules
Diskette drives

All mass storage devices
Processors

Controllers

Fans
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e Temperature sensors

e Cables (front/rear panels, audio, and USB ports)

Find additional information about POST error messages in the Service and Technical Reference
Guide, which is available at http://www.hp.com/support/workstation_manuals.

Basic troubleshooting

This section provides guidance on troubleshooting problems that you might encounter during the initial
setup process. Additional troubleshooting information is available in the Service and Technical
Reference Guide at http://www.hp.com/support/workstation_manuals.

General problems

You might be able to easily resolve the general problems described in this section. If a problem persists
and you are unable to resolve it yourself or if you feel uncomfortable about performing the operation,
contact an HP customer care center, or contact an authorized dealer or reseller. For a list of support
telephone numbers for your region, visit http://www.hp.com/support, select your region, and click
Contact HP in the upper-left corner.

Table 4-1 General installation problems

Problem

Cause

Solution

Workstation appears locked
up and will not turn off when
the power button is pressed.

Software control of the
power switch is not
functional.

Press and hold the power button for at least four seconds until the
workstation turns off.

Workstation will not respond
to USB keyboard or mouse.

Workstation is in
Standby mode.

Press the power button to resume from standby mode.

CAUTION: When attempting to resume from standby mode, do not hold
down the power button for more than four seconds. Otherwise, the
workstation shuts down and you might lose your data.

Workstation date and time
display is incorrect.

RTC (real-time clock) battery
might need to be replaced.

NOTE: Connecting the
workstation to a live AC
outlet prolongs the life of the
RTC battery.

Reset the date and time using Computer Setup (F10). If the problem
persists, replace the RTC battery. See the Service and Technical
Reference Guide for instructions on installing a new battery, or contact
an authorized dealer or reseller for RTC battery replacement.

Workstation pauses
periodically.

Network driver is loaded and
no network connection is
established.

Establish a network connection, or use Computer Setup (F10) to disable
the network controller.

Cursor will not move using
the arrow keys on the
keypad.

The Num Lock key
might be on.

Press the Num Lock key. The Num Lock light should not be on if you want
to use the arrow keys. The Num Lock key can be disabled (or enabled)
in Computer Setup (F10).

Cannot remove workstation
cover or access panel.

Solenoid hood lock, featured
on some systems, is locked.

Unlock the solenoid hood lock using Computer Setup (F10). The solenoid
hood lock FailSafe Key, a device for manually disabling the solenoid hood
lock, is available from HP. You will need the FailSafe Key in case of
forgotten password, power loss, or workstation malfunction. (This solution
not applicable to the xw8000/xw9000 series.)

The panel is locked
(xw6000/xw8000/xw9000
series).

Use the key located on the back of the unit to unlock the panel.
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Table 4-1 General installation problems (continued)

Problem Cause

Solution

Processor is hot.

Poor performance is

1. Make sure the airflow to and from the workstation is not blocked.
2. Make sure the fans are connected and working properly.

3. Make sure the processor heatsink is installed properly.

experienced. Hard drive is full.

Transfer data from the hard drive to create more space on the hard drive.

The user has memory
installed in a single channel
instead of in both channels.

Ensure DIMMs are matched and installed in both memory channels for
best performance.

System does not power on  System unable to power on
and the LEDs on the front of with power applied.

the workstation are not

blinking.

CAUTION: Internal components might be powered even when the
system is off. To prevent damage, disconnect the workstation power cord
before you remove a component.

To resolve this problem, choose one of the following:

A. Press and hold the power button for less than 4 seconds. If the hard
drive LED turns green, then:

1. Remove the expansion cards one at a time and try holding the power
button again for less than 4 seconds.

2. The problem might be on the system board. Contact HP for
assistance.

B. Press and hold the power button for less than 4 seconds. If the hard
drive LED does not illuminate green:

1. Verify that unit is plugged into a working AC power outlet.

2. Open the access panel and verify the power button harness is
properly connected to the system board.

3. Verify that all power supply cables are properly connected to the
system board.

4. Check the power supply functionality.

a. Disconnect the AC power.

b. Disconnect ALL internal power supply cables from the system board.
c. Plug in the AC power.

If the power supply fan spins and the BIST* LED lights, the power supply
is functional. The problem might be on the system board. Contact HP for

assistance.

If the power supply fan does not spin or the BIST* LED does not light, the
problem might be in the power supply. Contact HP for assistance.

* For BIST information, see the Service and Technical Reference Guide for your workstation.

Hardware installation problems

ENWW

You might need to reconfigure the workstation when you add or remove hardware, such as an additional
optical drive. If you install a plug and play device, some operating systems automatically recognize the
device and configure the workstation. If you install a non—plug and play device, you must reconfigure

the workstation after installing the new hardware.
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Table 4-2 Hardware installation problems

Problem Probable Cause Recommended Solution
Device is not seated or Ensure that the device is properly and securely connected and that pins
connected properly. in the connector are not bent down.

Cables of new external
device are loose or power
cables are unplugged.

Power switch of new Turn off the workstation, turn on the external device, then turn on the
external device is not turned workstation to integrate the device with the workstation system.
A new device is not on.
recognized as part of
the system. When the system advised Reboot the workstation, and follow the instructions for accepting the
you of changes to the changes.

configuration, you did not
accept them.

A plug and play board might Use Computer Setup (F10) to reconfigure or disable devices to resolve
not automatically configure  the resource conflict.

when added if the default
configuration conflicts with
other devices.

Workstation will not start. Wrong memory modules 1.

were used in the upgrade or
memory modules were
installed in the wrong

Review the documentation that came with the system to determine
if you are using the correct memory modules and to verify the proper
installation.

location. 2. If you still cannot resolve the issue, contact Customer Support.
3. Observe the beeps and LED lights on the front of the workstation.
See Diagnostic lights and audible (beep) codes on page 28 to
determine possible causes.
Workstation will not shut Proper steps were not 1. Shut down the operating system software.
down. followed.
2. Manually turn off power to the workstation by pressing and holding
the power button for four seconds.
CAUTION: Manually turning off the power bypasses the standby
state and can result in loss of data.
3. To reconfigure the power button to work in On/Off mode, run

Computer Setup (F10).

For more information about using Computer Setup, refer to the Service
and Technical Reference Guide, which is available through a link on the
Documentation and Diagnostics CD (http://www.hp.com/support/
workstation_manuals).

Diagnostic lights and audible (beep) codes

This section describes the front panel light (LED) error and operation codes as well as the audible codes

that might occur before or during the POST.
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Table 4-3 Diagnostic lights and audible codes

Activity

Possible cause

Recommended action

Green Power LED On. No
beeps.

Workstation on.

Green Power LED blinks
every two seconds.** No
beeps.

Workstation in Suspend to
RAM mode (select models
only) or normal Suspend
mode.

*%

Green Power LED is off.
No beeps.

Workstation in Suspend to
Disk or “Hibernate” mode.

Green Power LED blinks
three times, once per
second.** No beeps

Workstation in Suspend to
RAM mode (select models
only) or normal Suspend
mode.

Green Power LED blinks
four times, once per
second.** No beeps.

Workstation in Suspend to
Disk or “Hibernate” mode.

None

NOTE:

** — The BIOS option you select controls the green LED function during these suspend modes.

For the following LED activity and beeps, the beeps are heard through the chassis speaker. Blinks and beeps repeat for 5 cycles, after
which, only the blinks continue to repeat.

Red Power LED blinks two
times, once every second,
followed by a two-second
pause. Two beeps.

Processor thermal

protection activated by either

of the following methods:

CAUTION:

Internal components might be powered even when the

system is off. To prevent damage, disconnect the workstation power cord
before you remove a component.

e Afan might be blocked 1. Ensure thatthe workstation air vents are not blocked and the cooling
or not turning. fan is running.

e The heatsink and fan 2. Open the access panel, press power button, and verify that the
assembly is not processor fan is spinning. If the processor fan is not spinning, make
properly attached to the sure the fan cable is plugged into the system board header. Ensure
processor. the fan is fully and properly seated or installed.

3. Iffanis plugged in and seated properly, but is not spinning, the
problem might be in the processor fan. Contact HP for assistance.
4.  Verify that the fan assembly is properly attached. If problems persist,
there might be a problem with the processor heatsink. Contact HP
for assistance.
Red Power LED blinks three Processor not installed (not 1.  Verify that the processor is present.
times, once every second, an indicator of bad
followed by a two-second processor). 2. Reseat the processor.
pause. Three beeps.
Red Power LED blinks four ~ Power failure (power supply CAUTION: Internal components might be powered even when the

times, once every second,
followed by a two-second
pause. Four beeps.

is overloaded)

system is off. To prevent damage, disconnect the workstation power cord
before you remove a component.

1.

Open the access panel and ensure the following connections are
secure on the system board:

° 24—pin main power (all systems)
° 4—pin CPU (xw4000 series)
° 8—pin CPU (xw6000/xw8000/xw9000 series)

° 4—pin memory (xw8000/xw9000 series)
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Table 4-3 Diagnostic lights and audible codes (continued)

Activity

Possible cause

Recommended action

NOTE: Memory connector pin configurations vary, and can
have either a 4—pin, 6—pin, or 8—pin configuration, depending
on workstation series and model.

2. Check if a device is causing the problem by removing all attached
devices (such as hard, diskette, or optical drives, and expansion
cards.) Power on the system. If the system enters the POST, power
off and replace one device at a time; repeat this procedure until
failure occurs. Replace the device that is causing the failure.
Continue adding devices one at a time to ensure all devices are
functioning properly.

3. Check the power supply functionality.

a. Disconnect the AC power.

b. Disconnect ALL internal power supply cables.

c. Plug in the AC power.

If the power supply fan spins and the BIST* LED lights, the power supply
is functional. The problem might be on the system board. Contact HP for

assistance.

If the power supply fan does not spin or the BIST* LED does not light, the
problem might be in the power supply. Contact HP for assistance.

Red Power LED blinks five
times, once every second,
followed by a two-second
pause. Five beeps.

Pre-video memory error

CAUTION: Internal components might be powered even when the
system is off. To prevent damage, disconnect the workstation power cord
before you remove a component.

1. Reseat DIMMs.

2. Replace DIMMs one at a time to isolate faulty module.

3. Replace third-party memory with HP memory.

4. The problem might be on the system board. Contact HP for
assistance.

Red Power LED blinks six
times, once every second,
followed by a two-second
pause. Six beeps.

Pre-video graphics error.

CAUTION: Internal components might be powered even when the
system is off. To prevent damage, disconnect the workstation power cord
before you remove a component.

1. Reseat the graphics card.

2. The problem might be on the graphics card. Contact HP for
assistance.

Red Power LED blinks
seven times, once every
second, followed by a two-
second pause. Seven
beeps.

System board failure (ROM
detected failure prior to
video).

1. Clear CMOS.

NOTE: Refer to the Service and Technical Reference Guide for
your workstation model for detailed information on clearing CMOS.

2.  The problem might be on the system board. Contact HP for
assistance.
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Table 4-3 Diagnostic lights and audible codes (continued)

Activity Possible cause

Recommended action

Invalid ROM based on bad
checksum.

Red Power LED blinks eight
times, once every second,
followed by a two-second
pause. Eight beeps.

CAUTION: Internal components might be powered even when the
system is off. To prevent damage, disconnect the workstation power cord
before you remove a component.

1. Clear CMOS.

NOTE: Refer to the Service and Technical Reference Guide for
your workstation model for detailed information on clearing CMOS.

2. Upgrade the ROM using SoftPaq, either from your hard drive, CD,
diskette, or USB removable device (for example., HP Drive Key).
See the ROM Flash section of the Service and Technical Reference
Guide at http://www.hp.com/support/workstation_manuals. SoftPaq
is a self-extracting executable, which contains instructions for its
use, that enables you to upgrade your ROM. To download the
Softpaq executable, visit http://www.hp.com/go/
workstationsupport.

3. The problem might be on the system board. Contact HP for
assistance.

Red Power LED blinks nine
times, once every second,
followed by a two-second
pause. Nine beeps.

System powers on but does
not boot.

e  The problem might be on the system board. Contact HP for
assistance.

e  The problem might be in the processor. Contact HP for assistance.

System does not power on
and LEDs are not blinking.
No beeps.

System unable to power on.

CAUTION: Internal components might be powered even when the
system is off. To prevent damage, disconnect the workstation power cord
before you remove a component.

To resolve the problem, choose one of the following options:

Press and hold the power button for less than 4 seconds. If the hard drive
LED turns green, then:

1. Remove the expansion cards one at a time and try holding the power
button again for less than 4 seconds.

2. The problem might be on the system board. Contact HP for
assistance.

Press and hold the power button for less than 4 seconds. If the hard drive
LED does not turn on green then:

1. Check that unit is plugged into a working AC outlet.

2.  Open the access panel and check that the power button harness is
properly connected to the system board.

3. Check that all power supply cables are properly connected to the
system board.

4. Check the power supply functionality

a. Disconnect the AC power.

b. Disconnect all internal power supply cables.

c. Plug in the AC power.

If the power supply fan spins and the BIST* LED lights, the power supply

is functional. The problem might be on the system board. Contact HP for
assistance.
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Table 4-3 Diagnostic lights and audible codes (continued)

Activity Possible cause Recommended action

If the power supply fan does not spin or the BIST* LED does not light, the
problem might be in the power supply. Contact HP for assistance.

* Some workstation models (such as the xw4550) do not have the BIST LED functionality. * For BIST information, see the
Service and Technical Reference Guide.

Calling technical support

At times you might encounter an issue that requires technical support. When you call technical support:

Have your workstation readily accessible.

Write down the workstation serial numbers, product numbers, model names, and model numbers
and have them in front of you.

Note any applicable error messages.

Note any add-on options.

Note the operating system.

Note any third-party hardware or software.

Note the details of any blinking LEDs on the front of the workstation.

Note the applications you were using when you encountered the problem.

Note the power supply BIST status, if applicable.

Ef NOTE: When calling in for service or support, you might be asked for the Product Number (example:
PS988AV) of your workstation. If your workstation has a Product Number, it is generally located next to
the 10- or 12-digit Serial Number of your workstation.

NOTE: Referto Ventilation, COA label, and serial number label information on page 9 for the location
of the Serial Number label on your workstation. On most models, the serial number and product number
label are located at the rear of the workstation.

For a listing of all worldwide technical support phone numbers, visit http://www.hp.com/support, select
your region, and click Contact HP in the upper-left corner.
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